FloPoint® Elite Uroflow System Managing Exam Results in ScanPoint® with QuickPrint

Report Type Samples

There are two different styles of reports provided by the FloPoint® Elite system:
+ A summary report that provides only the peak flow measurement.
+ A detailed report that provides all measurements described above.
Past Exams and Voice Annotated Exams

Past exams and voice annotated exams must be printed through the ScanPoint® On-Line
interface. Both the summary and the detailed reports have been formatted to fit on a
sheet of 8.5"x11" paper in portrait orientation (Figure 19).

To print a past exam or voice annotated exam:

1. After opening the exam results, click on either the Summary or the Detail links to
open a preview of the printed report.

2. Once the preview is open, click on the Print This Page link to print the report to
your printer.

Exams Without Voice Annotation

Exams without voice annotation may be printed directly through QuickPrint to a sheet of
8.5” x 11” on your local or network printer, or to labels available with the ScanPoint®
Label Writer (Figure 24). Your QuickPrint preference settings will let you select which
report format you want to print and what printer to use.

NOTE: The Label Report cannot be printed from ScanPoint® Online.
Printing Results from the Last Exam Performed

The last exam performed by your FloPoint® Elite may be re-printed through the
QuickPrint interface by clicking the PRINT LAST ExAM button. QuickPrint reports may be
printed to a sheet of 8.5” x 11" on your local or network printer, or to labels available with
the ScanPoint® Label Writer. Use QuickPrint preference settings to select the desired
report format and printer.
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Figure 19. ScanPoint® Online Detail Report

Exam Date & Time: wednesday, June 20, 2007 9:35:13 AM
Patient 1D: Example

Patient Name: Patient

Operator: Operator

Phiysician: Physician

Gender:

Position;

Marmal Void for Patient:

Peak Flow: 20.0 mi/s

Average Flow: 9.4 s
Time to Peak Flow: 13 H
Vioided Volurne: 38 ol
Flow Time: 4.0 H
Pattern: Continuous
Waid Time: 4.0 5

Exam Overview

Measurements
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Result: Good Exam

FloPoint Summary
EloPoint Details

Customer comments
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Managing Exam Results in ScanPoint® with QuickPrint

Figure 20. ScanPoint® Online Detail Report Preview

Print This Page Return to Examn Results

FloPointe Details
Exarn Date & Time: mursdav, June 21, 2007 9:48:43 P e ak Fl ow: 20.0m| /5
Patient ID: Example Average Flow: 9.4l
Patient Narne: Patient Tirne to Peak Elow: 305
Operator: Operator Voided Yolume: Sl
Phiysician: Phiysician Flow Time: 5.4
Pattern: Continuous
Yoid Time: S.ds
Gender: Male
Position: Standing
Mormal Void for Patient: Yes
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Figure 21. ScanPoint® Online Summary Report Preview

Print_This Page Return to Exam Results
FloPointe Summary
Examn Date & Time: Thursday, June 21, 2007 9:48:43 AM
Patient ID: Example
Patient Name: Patient
Operator: Operator
Physician: Phiysician
Gender: Male
Position: Standing
MNormal Yoid for Patient: Yes
Peak Flow 20.0miss
50
45+
40+
35+
304
)
E 25
G ]
154
104
5+
0 1 2 3 4 5 6 7 8 9 10
Time (s)
Physician Signature:
ES?D-DI_?S | 70406[2 | 87893
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Figure 22. QuickPrint Full Page Detail Report

Versthor® ScanPoint®  Exam Results

FloPoint ® Results Peak Flow  20.0mys
Exam Date & Time June 21, 2007 9:48 AM Average Flow 9. 4miis
Patient ID Example Time to Peak Flow 3.0s
Patient Name Patient Voided Volume 51mi
Operator Operator Flow Time 5.4s
Physician Physician Pattern Continuous

Void Time 5.4e

Gender Male

Position Standing

Normal Void for Patient Yes

& (mis)
¥

Time (5]

Time (5]

Physician Signature

0570-0175 | 7040602 | 87893
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Figure 23. Quick Print Full Page Summary Report

Verathon®Scanfoint® Exam Results

FloPoint ® Results Summary

Exam Date & Time
Patient ID

Patient Name

Operator

Physician

Gender

Position

Mormal Void for Patient

Thursday, June 21, 2007 9:48 AM
Example

Patient

Operator

Physician

Male

Standing

Yes

Peak Flow 20.0 ml/s

@ (mlis)
¥

Physician Signature

0570-0175 | 7040602 | 87893

Figure 24. QuickPrint Detail Label Report

FloPoint ® Report

0570-0175 | 7040602 | 87893

June 21, 2007 9:48 AM
Exam Date & Time

Example

Patient 1D

Patient

Patient Name

Operator

Opperator

Physician

Physician

G (mis)

Time (=)
Standing Yes
Position Normal Void for Patient

Peak Flow 20.0mus

Page 1 of 2
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FloPoint ® Report 0ST0-0175 | TO40602 | 87853
Peak Flow 20.0 ms  Average Flow 9.4 mus
Time to Peak 3.0s Voided Volume 51 ml - fg;
Flow + 30]
2 30y
FlowTime  54s  Pattem Continuous £ ;o1
Void Time  5.4s 01 23 456 76810
Time (5)
Peak Flow 20.0miis Page 2 of 2

Figure 25. QuickPrint Summary Label Report

FloPoint ® Report 0570-0175 | TO40602 | 87853
June 21, 2007 9:48 AM 50
Exam Date & Time 404
Example Z 30
Patient 1D E ]
Patient @ miﬁ
Patient Name C_ - ! ! ! : ! ! ! !
Operator 01 2 3 4 5 6 7 8 9 10
Operator )
Physician Time ()
Physician Male Standing Yes

Gender Position Normail Void for Patient
Peak Flow 20.0miis

Changing Your Preferences

The Preferences dialog box allows you to set your ScanPoint® login information,
QuickPrint prompts, default information and print settings, and preferred warnings.

You can also use the Preferences Wizard to set many of your preferences — see “Step
5: Setting ScanPoint® User Preferences” on page 33.

1. From the Tools menu, choose Preferences. The Preferences dialog box is
displayed.

Preferences

ScanPoint® Lagin l Exam Sa‘ﬂinga] Report Settings l System Settings ]

Quick Prirt uses your ScanPoirt® Online

Change Your ScanFoint® Login User Name and Password to communicate
with our sarvers.
Plezse enter your User Mame and Password
User Name:  |ussrtsst to the left and click the "Connect” buttan.
WARNING: Fyou fail to authenticats to
Passwaord: ScanPoint® wih the new User Name, you

will be: unable to use Quick Print until you

successiully log in.
Connect When you successfully log in, your user

preferences wil be changsd to match the
new Ueers eaved preferances [default f
none saved previously). The preferences
for the previous uaer will ke saved.

ScanPoint® URL: ||'|Hpe:;"z'i'|'ry.scanpaint.corn Save...

Lpply Defaults | Save 4s All Users Default OK | Cancel
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2. Consult the following table for the Preferences you can set up or change. When
you are finished setting your preferences, click the ok button to save your
changes and exit the Preferences dialog box, or:

¢ Click the AppLY DEFAULTS button to reset all your Preferences to their

default settings.

+ Click the SAVE As ALL USERS button to set the Preferences settings for all
users on your computer.

+ Click CaNCEL to cancel any changes you have made.

To

Log in to ScanPoint® or
change from one user
profile to another.

Do this

1. Click the ScanPoint® Login tab.

2. Enter the User Name and Password assigned to

you by Verathon®.

3. Click CoNNECT.

NOTE: This ScanPoint® User Name and Password
will apply every time you log in to Windows using your
current user account. There is no time-out period: the
User Name and Password you enter will remain active
until you change them.

Change the URL of the
ScanPoint® Web site.

NOTE: Do not perform this procedure unless
instructed to do so by the Verathon® Customer Care
Department.

Have QuickPrint prompt
you for exam details after
each exam.

Click the Exam Settings tab.

Indicate which prompts you want displayed for
each exam by placing a check mark in the
appropriate check boxes.

If desired, in the Default Operator text box, enter
the name you want to automatically appear in the
Operator text box.

If desired, in the Physician text box, enter the
name you want to automatically appear in the
Physician text box.

NOTE: You can always overwrite these default
names for a particular exam

Choose a default printer for printing exams.
NOTE: You will be able to change printers for a

particular exam only if you place a checkmark in
the Prompt for Printer check box.

page 78

User’s Manual



FloPoint® Elite Uroflow System

Managing Exam Results in ScanPoint® with QuickPrint

To

Specify default names for
the Operator and Physician
text boxes in the Exam
Details dialog box.

Do this

1.
2.

Click the Exam Settings tab.

Place a check mark in the Prompt for Exam
Details check box.

In the Default Operator text box, enter the name
you want to automatically appear in the Operator
text box.

In the Physician text box, enter the name you
want to automatically appear in the Physician text
box.

NOTE: You can always overwrite these default
names for a particular exam.

Specify a default printer.

Click the Exam Settings tab.

Click the down arrow () on the right side of the
Default Printer check box and choose the printer
you want.

If you do not place a check mark in the Prompt for
Printer check box, this printer will be used every
time you print a new exam.

Have ScanPoint® with
QuickPrint prompt you to
save a PDF (a printable
copy of the exam) after
each exam.

Click the Exam Settings tab.

Place a check mark in the Prompt to Save Exam
PDF check box.

If desired, enter a default location for saving
exams in the Default Save Location text box. You
will always be able to override this setting for a
specific exam.

Have ScanPoint® with
QuickPrint prompt you for a
report type.

1.
2.

Click the Report Settings tab.

Place a check mark in the Prompt for Report Type
check box.

To specify a default report type for each

FloPoint® Elite device you have available, click the
down arrow () to the right of the text box and
select the appropriate type.

View sample report types.

Click the Report Settings tab.
Click the View Report Type Samples link.

You can also view report samples in this manual,
starting on page 71.
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To Do this

Specify a default report for 1. Click the Report Settings tab.

each exam type. 2. Click the down arrow (+) to the right of the

appropriate instrument text box and select the
appropriate report type.

If you do not place a check mark in the Prompt for
Report Type check box, these report types will be
used every time you print a new exam.

Change the location for NOTE: Do not perform this procedure unless
updates to ScanPoint® with  instructed to do so by an authorized Verathon®
QuickPrint. representative.

1. Click the System Settings tab.

2. Inthe Update URL text box, enter the new Web
site location given to you by Verathon®.

Turn on or turn off specific 1. Click the System Settings tab.

warning messages. 2. Place a check mark in the check box(es) next to

the warning(s) you want to receive.

Exiting QuickPrint or Hiding the QuickPrint Window

You can close the QuickPrint window without exiting the program, or you can exit
QuickPrint completely.
Closing the QuickPrint Window without Closing ScanPoint®
To hide the QuickPrint window, do one of the following:
+  Click the minimize button in the upper right corner of the QuickPrint window.

¢+ Go to the File menu and select CLOSE. The QuickPrint window closes. The
ScanPoint® icon visible in your system tray indicates that the program is still
running.

To Exit QuickPrint Completely

+ If a QuickPrint dialog box is currently displayed, go to the File menu and
select EXIT.

+ If a QuickPrint dialog box is not currently displayed, right-click the QuickPrint
icon in the system tray and select EXIT.

A dialog box appears asking you to confirm that you want to exit QuickPrint.
Click ok.
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Calibration

To make sure the FloSensor® is providing accurate measurements, it must be calibrated
at prescribed intervals.

The entire calibration process takes approximately 15 minutes.

You can calibrate the FloSensor as often as you like; you do not have to wait for the next
scheduled calibration date. However, at a minimum, you must calibrate the FloSensor
every 12 months.

NOTE: If your facility has signed up for the ScanPoint® Online Service Plan, you will
automatically receive the Calibration Fluid 4-pack and a Calibration Quick Reference
Card approximately 30 days before your FloSensor requires calibration (Figure 26).

Figure 26. FloPoint® Elite Calibration Fluid and Calibration Quick Reference Card.

Calibration Fluid Pouch
Pouch containing unique fluid for use in calibrating the
FloPoint® Elite.

FloPoint® g
P

0800-0331

FloPoint® Elite Calibration Quick Reference Card:
E Provides instructions for the FloPoint® Elite calibration
procedure.

il | E
Q-0 (€]
=

0900-1444

Determining the Number of Days Until Required Calibration

1. Clear the Remote of saved exam data by placing it in the ScanPoint® Docking
Station and saving the exam data to ScanPoint®.

2. Remove the Remote from the ScanPoint® Docking Station. Press and hold down
the Start button for at least five seconds. The LCD screen displays the “setting

User’s Manual page 81



Calibration

FloPoint® Elite Uroflow System

sun” icon and the number of days until the required calibration date - 120 in the

illustration below.

TE‘B‘*@

NOTE: When the Remote displays 4% and 000 calibration is required.

When there are 20 days remaining before the next required calibration, a warning

message appears in ScanPoint® with QuickPrint (Figure 27).

Figure 27. ScanPoint® Calibration Warning Message

A The following instrument(s) require
A calibration within 20 days.

Part Number [ Serial Number [ Next Calibration Date l
0570-0154 1072 2006/3/23

05700167 5064 Expired

0570-0154 7379 2006/3/24

To view the date for the next scheduled calibration:

1. Place the Remote in the ScanPoint® Docking Station.

2. In ScanPoint® with QuickPrint, go to the View menu and select INSTRUMENT

DETAILS. The Instrument Details dialog will open (Figure 28).
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Figure 28. Instrument Details Dialog

3¢} ScanPoint® QuickPrint
Eile View Tools Help

- Cradle Details — :
2 & a

1 Serial 2671
v :'l Description:  ScanFoint (R) Communications Cradle
"1 Instrument Detaits
Name: Ii
Part: 05700167
Serial: 741
Kernel Version:  7.607 Scitware Version: 259

b0 760006602

Last Calibration: 3762006 527 AM
Next Calibration: 3782008 9271 AM

]

The last two lines of information in the dialog provide the date of the last
calibration and the date of the next required calibration.

Click the green RETURN TO INSTRUMENT OVERVIEW button to close the dialog and
return to the Instrument Overview (Prepare New Exam) pane.

Calibrating the FloSensor using ScanPoint® with QuickPrint

1. Place the Remote in the ScanPoint® Docking Station.

When the ScanPoint® QuickPrint window opens, select the “Tools” menu and
click the “Calibrate Instrument” menu item.

The Calibrate Instrument screen will open. Click the CALIBRATE button on this
dialog to begin configuring the Remote for the calibration procedure.

When the Remote is configured, take it, along with a paper funnel, the pouches
containing the Calibration Fluid (available from Verathon®), and the FloCharger
(with FloSensor inside) to the toilet.

Place the Remote, funnel, and Calibration Fluid on the counter. Place the
FloCharger gently on the floor.
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Put on a pair of gloves. Remove
the FloSensor from the FloCharger
and hang it in the toilet bowl just
as you would for an exam.

Place the funnel on top of the
FloSensor and push the tabs
under the handles to hold it
securely in place.

Pick up the Remote and press the button once to start
recording an exam. The Remote will play a “tune up” g
chirp indicating that the FloSensor is ready to measure @
the calibration flow.

Slowly pour the contents of one of the Calibration Fluid Ready to calibrate
pouches onto the side of the funnel closet to the front of the toilet. The flow rate
should not exceed 10ml/s as measured by the Remote.

When the pouch is empty, click the Start button once to end the exam.

Depending on what appears on the Remote display, the calibration was either
successful (go to step 8), or unsuccessful (go to step 10).

If the Calibration was Successful

8.

If the calibration is successful, four arrows and “3 - 3”

are displayed. The Remote plays a “siren” chirp 3 - s'-ﬂk
indicating that it needs to be placed back in the oF @
ScanPoint® Docking Station to complete the calibration *

process.

When you have performed a successful calibration - or when three calibration
flows have been attempted - return the FloSensor to the FloCharger and flush
the toilet.

Remove your gloves and return the Remote to the ScanPoint® Docking Station
for re-configuration.

If the Calibration was Unsuccessful

10. The Remote will emit an error beep.

A maximum of three calibration flows can be conducted
during a calibration exam.

7-3"‘ B

The display shows the
current attempt number
and the total allowable
number of attempts

Return to step 6 to repeat a calibration flow.

Completing Calibration possible, in this case,

“one out of three.”

11. When you have performed a successful calibration - or
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when three calibration flows have been attempted - return the FloSensor to the
FloCharger and flush the toilet.

Remove your gloves and return the Remote to the ScanPoint® Docking Station
for re-configuration.

NOTE: If calibration was unsuccessful after three attempts: Return to ScanPoint®
and complete the Calibration Exam. You may continue to use your FloPoint® Elite
or contact Verathon Medical® Customer Care for assistance at 1.800.331.2313.

12. Return the Remote to the ScanPoint® Dockin% Station. The Remote will upload

the calibration data to ScanPoint®. ScanPoin

t~ verifies the calibration and

assigns a new expiry date to the FloSensor. This should take only a minute.

13. ScanPoint® completes the calibration process by re-installing the Remote
software so the Remote can perform patient exams.

14. If desired, select PRINT to print a Calibration Report (Figure 29).

Figure 29. Calibration Report

Point

Calibration Result:

Calibration Date:
Instrument Model:
Instrument Serial Nurnber:

Control Functionality:
Cradle Communication:
Device Communication:
Device Flash RaM:

Device ROM:

Device DSP:

Device Self-Test:

Device Application Upload:

Upload to web:
Image Acquisition:
Image Intensity:
Image Alignment:

Customer Name:
Customer Address:

Device Application Execution:

Calibration Report

Success

™~
\ VERATHON

Wed Jun 20 12:58:08 PDT 2007

ScanPoint® Remote
5310701

Tests:
PASS
PASS
PASS
PASS
PASS
PASS
PASS
PASS
PASS
PASS
PASS
PASS
PASS
All Tests PASSED
Werathon Medical
21222 30th Drive SE
Print This Page
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Troubleshooting

Help Resources

Verathon® provides an extensive array of customer care resources, described in the table
below.

You can obtain copies of this manual, Quick Reference Cards, and clinical studies and
view training videos by accessing the Verathon® Web site at www.verathon.com or by
contacting your Verathon Medical® representative. A complete listing of contact
information is provided on page 21.

Resource Description

FloPoint® Elite Quick Summary of procedures for using the FloPoint® Elite
Reference Cards Uroflow System.

This manual Refer to the troubleshooting suggestions that begin

on page 88 for solutions to common problems.

The Verathon® Web site The Verathon® Web site (www.verathon.com)
provides the latest user manuals, quick reference
cards, clinical studies, and training videos.

To find the latest FloPoint® Elite information, from
the Verathon® Home page, select “FloPoint” Elite.”

ScanPoint® with QuickPrint ScanPoint® with QuickPrint software.
Software Install CD

FloPoint® Elite In-Service CD  Includes FloPoint® Elite User's Manual and Quick
Reference Cards.

ScanPoint® Help From your ScanPoint® application, select Help from
the toolbar at the top of the ScanPoint® window.

ScanPoint® Online ScanPoint® Online provides:

+ Access to real-time troubleshooting from
Verathon®.

+ The ability to calibrate and certify their
devices online anytime they wish .

+ Automatic software upgrades.

+ Automatic data backup and archiving
(HIPAA compliant).
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ScanPoint® Diagnostics This ScanPoint® tool checks your system and lets
you know of any problems or needed updates
(Figure 30).

To access this information, from the ScanPoint®
menu select Tools > Diagnostics.

Figure 30. ScanPoint® Diagnostics

Diagnostics

Beginning diagnostics...

- MWARNING: current ScanPoint URL has been changed from the default URL
...DKAY

Checking application data...

...DKAY

Diagnostics complete.

| Go I Close | Copy to Clipboard | Tum OFF Tracing |

Resource Description

Premium Warranty Total A Verathon® insurance plan that provides all the
benefits of ScanPoint® Online (preceding

Customer Care Plan
paragraph) plus:

+ Instrument insurance: A perpetual warranty
against outdated technology with free
upgrade / replacement when your device is
no longer manufactured.

+  Free loaner program.

+ Free shipping.

Phone support In North America, call: 1.800.331.2313.
International customers, please refer to the list of
Customer Care phone numbers on page 21.

User’s Manual page 87



Troubleshooting FloPoint® Elite Uroflow System

Diagnosing Problems

ScanPoint® Problems

Issue / Problem Answer

How can | improve my To view recommended security and privacy practices,
system’s security and from the ScanPoint® Help menu and select “Security
privacy? Best Practices.”

When | insert the If the installation screen does not automatically open

ScanPoint® disk into the when you insert the ScanPoint® CD, you can start
CD drive, the installation installation this way:

screen does not appear. 1. On the Windows taskbar, click Start > Run. The
Run dialog will open.

2. Type: D:\setup.exe (where D is the name assigned
to the CD drive) and click Ok.

| can’t access the Check your Internet connection.
ScanPoint® Web site.

| can’t start ScanPoint®. Exit all open Internet Explorer windows and restart the
program.

I can’t log onto You may have mistyped your login name and password.

ScanPoint®.

Try entering them again making sure that they are
spelled correctly and that you are using upper and lower
case letters as appropriate.

If you can’t remember your login name or password,
click Get help with sign in.

My ScanPoint® session Your ScanPoint® session has timed out because it was
has expired. idle for over 12 hours. You must log in again.

Why do some text boxes A red asterisk indicates that the text box cannot be left
have red asterisks (*)? blank. You are required to enter text in any field marked
with a red asterisk.

| can’t find the exam Make sure the exam was transmitted to your account

results | want. and not someone else’s. If it was transmitted to your
account but you still can't find it, one of the following
conditions may apply:

+  ScanPoint® may not have validated the exam
yet. Wait a few minutes and try again.

¢+ The exam results may have already been
viewed. If so, go to the Past Exams menu and
request the results again.
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Issue / Problem Answer
A security warning You may be trying to run an outdated version of
appeared on my screen. ScanPoint®, or the driver ScanPoint® needs is not

available. If either is true, click Yes in the security
warning dialog box.

Why do | get an error A minus si(gn (=) cannot be the first character in any
message saying that | ScanPoint™ text box. Re-enter the digits without the
must enter a positive minus sign.

number?

An error message Click the HELP button on any ScanPoint® screen and
appeared on the follow the directions provided.

. ®
ScanPoint”screen. If you still have questions, contact the Verathon

Medical® Customer Care Department at
1.800.331.2313.

My account has expired. Contact Verathon® at 1.800.331.2313 to reactivate your
account.

I can’t access some menu You can access only the features for which you have
options. signed up.

ScanPoint® Remote Problems

Issue / Problem Answer

The Remote does not + Make sure you are within 3 meters of the FloSensor.
recognize the FloSensor.
Or, the FloSensor is not
communicating with the
Remote.

Make sure the FloSensor battery is charged and the
Remote battery is charged.

The Remote does not turn The Remote battery may need to be charged.

on. 1. Place the Remote in the ScanPoint® Docking

Station (make sure the computer is turned on) for up
to 8 hours.

2. If the scrolling battery icon does not appear after 2
hours, press the Reset button on the rear of the
Remote.

3. For more information about charging the Remote,
see “Charging the ScanPoint® Remote Battery” on
page 44.
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Issue / Problem Answer

The ScanPoint® Remote + Make sure the Remote is seated properly in the
isn't working. ScanPoint® Docking Station.

+ Make sure the Remote battery is charged.

+ If the Remote is charged but still won't turn on, press
the Reset button on the back of the Remote using
the activation tool provided with you FloPoint® Elite
system.

If the Remote is still not functioning properly, contact
Verathon Medical® Customer Care at
1.800.331.2313.

The ScanPoint® Remote Check the connections between the ScanPoint® Docking
won’t communicate with Station and the USB connector on your computer.

1 ®
ScanPoint™. If the Remote is still not functioning properly, contact
Verathon Medical® Customer Care at 1.800.331.2313.
The ScanPoint® Remote It is normal for the Remote to beep when:
beeped.

+ Itis beginning or ending a process.

+ ltis entering sleep mode to conserver battery life.
Press any button to “wake up” the Remote.

+ Battery power is low and the Remote needs to be
recharged. (See “Charging the ScanPoint® Remote
Battery” on page 44.)

+ Radio contact is weak. Move the Remote closer to
the ScanPoint® Docking Station.

Error Messages

Message Answer

User’'s comments may Enter a reason for the rejection in the Reason text box.
not be empty during
exam rejection.

Exam already has exam You have already transmitted the results of the exam.
data uploaded. Please You may conduct a new exam, if desired.
start another exam.

This field may not be You must make an entry into the appropriate text box. It
empty. cannot remain blank.
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Message Answer

You must enter a positive A minus sign (—) cannot be the first character in any
number. ScanPoint™ text box. Re-enter the digits without the
minus sign.

Error Codes

Code Meaning Resolution

Err1 FloSensor did not respond to Self- Charge the FloSensor.
Test Request from ScanPoint®
Remote.

Err 2 FloSensor did not respond to a stop Reset FloSensor by placing it on
exam request from ScanPoint® the FloCharger.

Remote. Exam information is
complete and a new exam could be

started.

Err 3 The calibration exchange between the Repeat the calibration. If it still
FloSensor and the ScanPoint® fails, upload data to ScanPoint®
Remote failed. and call Verathon Medical®

Customer Care.

Err 4 At least 1 second of continuous data Alert on ScanPoint® Remote
was lost due to a radio indicates loss of radio data.
communication failure. Move ScanPoint® Remote closer

to the FloSensor during an
exam. If alert comes after patient
has completed voiding, there will
be no impact on exam result.

Err 5 The ScanPoint® Remote failed to Repeat the operation. (Not a
write a value to the FloSensor flash. function performed by

customers. Call Verathon
Medical® Customer Care.)
Err 6 The ScanPoint® Remote failed to read Repeat the operation. (Not a
a value from the FloSensor flash. function performed by
customers. Call Verathon
Medical® Customer Care.)
Err 7 The FloSensor battery has insufficient Charge the FloSensor.

charge to perform and exam.
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Code Meaning Resolution
Err 8 The FloSensor motor is moving too Check the FloSensor for
slowly and could no longer be something blocking the motor. If
controlled. necessary, remove the funnel
retainer and clean the FloSensor
(see page 56). Re-assemble and
attempt the exam again. If the
problem persists, contact
Verathon Medical® Customer
Care.
Err 9 The FloSensor is requiring too much Either the flow rate is too high or

current to control the speed.

Err 10 The FloSensor internal temperature is
too high.

there is something preventing
the motor from moving. Remove
the funnel retainer and clean the
FloSensor (see page 56). Re-
assemble and attempt the exam
again. If the problem persists,
contact Verathon Medical®
Customer Care.

Let the FloSensor cool off and
attempt to perform another
exam. If the problem persists,
contact Verathon Medical®
Customer Care.

Application Log

If you are experiencing problems, the Customer Care Department at Verathon Medical®
may send you a message requesting permission to view your application log (Figure 31).
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Figure 31. Application Log Request

Message 2 of 2 X

One of our Customer Service R epresentative stalf
members has requested thatyou upload your QuickPint
log files for analysis.

Representative: CSH
Date/Time: 10/20/2005 3:11 PM

Do you wish to securely upload your current log file?

Yes No

L ——

The application log is a record of all the actions ScanPoint® has performed. No patient
data is included. You can preview your application log by going to the View menu and
selecting Application Log. Figure 32 shows a typical application log

Figure 32. Application Log Data

Date/Ti | Type | ThieadD | Message |
672072007 7:06:76PM info 1182 Displaping LogFile... )
6/20/2007 12:54:14 PM Dulap 7928 Cradle found: 00002774/ScanPoint [R) Communicati
6/20/2007 12:54:13 PM Info 7928 Opening Socket to Service

£/20/2007 12:54:01 PM Info 1152 FUS Assembly Registered

6/20/2007 12:54:01 PM Info 7328 Logfile backed up to disk

£/20/2007 12:54:01 PM Info 1152 Application Starting... Version 1.3

6/20/2007 12:53:56 PM Info 8080 Logfile backed up to disk

6/20/2007 12:53:56 PM Info 6424 Logfile backed up ta disk

B/20/2007 12:34:22 PM Info 4028 Sending Application ta Device - Pait: 570017400 Se
6/20/2007 12:34:11 PM Info 3044 Logfile backed up ta disk

6/20/2007 12:34:11 PM Info 4028 Retrieving Calibration App for DCD Part: 570017500
6/20/2007 12:05:21 PM Info 3516 Logfile backed up to disk

£/20/2007 12:01:59 PM Info 5372 Remaving Cradle Serial: 00001757

£/20/2007 12:01:56 PM Info 5372 Sending Refresh message to Service

6/20/2007 12:01:56 PM Info 5372 Processing Refresh Request

£/20/2007 12:01:48 PM Dulap 2912 RRD file received from cradle 00002774 and saved |
6/20/2007 12:01:48 PM Info B424 Beginning Exam Data Download Process for Remote
£/20/2007 12:01:48 PM Info 6424 Downloading SRam Scan from DCD Serial 5310701
5}fﬂf?ﬂﬂ7 11-Rr 401 AM Nulan 10N& Cradle faund: NMNNN2774/5canPaint IR I'annT\ mir‘..:jll

Close I
A
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